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Scope

This document, aimed at Toolkit Coordinators and advanced Toolkit users, contains troubleshooting information for Customer Service Toolkit v5.1 Service Pack 1 and the previous version (v5.0, Build 66).   Information is organized into the following sections: (1) Configuration and Set Up, (2) Installation Issues, (3) ArcGIS Issues, 
(4) Tools Menu, (5) Framework Tabs, (6) Customer Tabs, and (7) Utilities.
Technical Support

To report Toolkit issues, contact the ITS Help Desk at 1-888-311-1444, or https://merlin.sc.egov.usda.gov/magicsshd/, or send email to ToolkitSupport@ftc.usda.gov.
Online Help

Toolkit Online Help is available to Toolkit users at all times at the following Web site, regardless of whether Toolkit is running:  http://cst.nrcs.usda.gov/Toolkit/Help/.  Alternatively, users may access Toolkit Online Help by clicking on the Help button in Toolkit.

Hundreds of help topics are included in Toolkit Online Help, which features an easy-to-browse index and a comprehensive search tool.  Simply type in a keyword or phrase in the Search field (and depress Enter) to generate a list of Toolkit help pages related to that topic.  To navigate to a specific Help page, click on a topic title listed in the left-hand frame.

Web Site

For the latest information on Toolkit, visit the Toolkit Web site at:

· http://www.itc.nrcs.usda.gov/toolkit/
In addition to Frequently Asked Questions, training resources, and installation information, the Toolkit user guides, tech notes, and helpful hints are available for download from the Training and Support page.
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Toolkit Troubleshooting Guide
Configuration and Set Up

Enroll Toolkit Users

Problem:  A user cannot be enrolled in Toolkit.
Resolution:  Check that the user has been granted the required permissions.  Only Toolkit/GIS Coordinators can enroll users in Toolkit (for specifics, see the "Enroll Toolkit Users" and “Toolkit Permissions” topics in the Toolkit Online Help). 
Lost Permissions for Toolkit
Problem:  Users permissions have been reset for ProTracts recently and now the user has lost Toolkit permissions. 
Resolution:  Toolkit 2004 and ProTracts share the same User Permissions database.  An office or county added to one program (e.g., Toolkit), will be viewable in the other program (ProTracts).  Therefore, do not remove an office or county from the User's Office Permission or User's County Permission unless neither program requires permissions for that office or county.

Problems with Permissions

Problem:  When checking customers back in, the user obtains a message stating that s/he does not have permissions to the F: drive.

Details:  One of the most common mistakes in installing Toolkit 2004 v5 is the failure to set up permissions as directed in the installation guide.  The procedure to set up permissions after creating the Customer Files Toolkit folder on the server is provided below, for your reference.  If a user obtains an error that appears to be related to user permissions, ask the ITS System Administrator to verify that the permissions are properly set for this user’s customer folders on the F: drive.

· The most common steps that are skipped over inadvertently during installation are steps 10, 12, 14, and 19.  In steps 10, 12 and 14, the permissions must be set to Full Control.  

· As the instructions note, it can take quite a while for permissions to be updated on all customer files.  Some sites have thousands of customer files that need to be updated.  It is important to wait as long as needed for all permissions to be updated.

Resolution:  Ask the ITS System Administrator to verify that the permissions are properly set for this user’s customer folders on the F: drive.
Create Customer Files Toolkit Folder on the Server

Source:  Toolkit 2004 v5.0 Installation Guide
The ITS System Administrator logs onto the field office server and completes the following steps.

1. Make sure that there is adequate space to make a complete copy of the Toolkit 4.1 customer data located in the folder \\<server name>\data\Customer Files. 

2. Create a copy of the Customer Files folder containing all the customer folders and rename it to Customer Files Toolkit. The ITS System Administrator may need to set Full Control permissions for domain users on all subfolders and files in the Customer Files folder in order to create a complete copy of the Customer Files folder.

Note:  At this point, both the Customer Files and Customer Files Toolkit folders are present.

Change Permissions on the Customer Files Toolkit Folder

The ITS System Administrator changes the permissions on the new Customer Files Toolkit folder (i.e., \\<server name>\data\Customer Files Toolkit) and adds the Toolkit service account for the appropriate domain (AgWest\Thaddeus.W.Uccello, AgCentral\Thaddeus.C.Uccello, or AgEast\Thaddeus.E.Uccello)

3. Right-click on the Customer Files Toolkit folder and select Properties. 

4. Select the Security tab. 

5. Uncheck “Allow inheritable permissions from parent to propagate to this object.”  Click Copy.

6. Reset permissions for Everyone to only allow read access by selecting Everyone.

7. Uncheck all permissions except for Read.  Click Apply.

8. Click Add to add the Toolkit services account appropriate for the domain.

9. Type in the appropriate Toolkit services account (e.g., Thaddeus.W.Uccello) using one of the accounts listed below. 

· AgWest\Thaddeus.W.Uccello

· AgCentral\Thaddeus.C.Uccello

· AgEast\Thaddeus.E.Uccello

10. Click Check Names.  
11. When the Toolkit services account is found, click OK. 

12. Set permissions to Full Control. Click Apply.

Note: If the Domain Admins and/or SYSTEM groups are not present, add the missing groups and set their permissions to Full Control.

13. To add the Domain Admins group, click Add.  Type “Domain Admins” into the dialog box.  Click Check Names.  Click OK. 

14. Select Domain Admins.  Set permissions to Full Control.  Click Apply.

15. To add the SYSTEM group, click Add.  Type “SYSTEM” into the dialog box.  Click Check Names.  Select SYSTEM in the Select Matching Items dialog box.  Click OK.  Click OK again.

16. Select SYSTEM.  Set permissions to Full Control.  Click Apply.

17. Remove all other group or user names, EXCEPT for Administrators (if present), Domain Admins, Everyone, SYSTEM, and the Toolkit services account (e.g., Thaddeus.W.Uccello), by selecting the group or user name and clicking on Remove.

18. Click Advanced.

19. Check “Reset permissions on all child objects and enable propagation of inheritable permissions.”  Click OK.

20. Click Yes in the Security dialog box.  

21. Wait for permissions to be updated.  (This could take a long time to reapply permissions to all files within the Customer Files Toolkit folder.)

22. Click OK.

Setting Up Affiliates in Toolkit
Problem:  An affiliate is having difficulties getting set up in Toolkit.

Resolution:  To use Toolkit 2004, affiliates must meet the following requirements:
23. The user must have access to a CCE computer (see the table of CCE platforms in the Installation/Deployment question) that has Toolkit 2004 and any desired optional software installed and configured (see the Toolkit Software question).
24. The workstation must be on the USDA Backbone (or have a connection to the USDA Backbone through VPN Client).
25. The user must obtain a Level 2 eAuthentication account (see the eAuthentication Level 2 Account question for more information).
26. The State Toolkit/GIS Coordinator must set up the appropriate user permissions. (If your user permissions are not set up, you will be unable the access the appropriate data in the National Conservation Planning Database.)

Common Mistakes
27. When applying for a Level 2 eAuthentication account, the user will need to visit a Local Registration Authority (LRA) and show a valid photo ID (e.g., state-issued driver's license). For more information on eAuthentication requirements or to locate a nearby Local Registration Authority, see the eAuthentication Web site at http://www.eauth.egov.usda.gov/ or call 800-457-3642.  (The instructions for setting up Affiliates to user NRCS web-based applications are found in:
http://ias.sc.egov.usda.gov/Help/Affiliates/docs/USDAAccountsForNRCSAffiliates.pdf 
Information on how to update information in OIP and CAMS is not covered.)
28. In some instances, if the user is not on the drop-down list when the Toolkit Coordinator is trying to set permissions for the user on the Permissions Web site, then it is likely that the user has obtained level 2 access, but has not been assigned the necessary role she/he needs to access Toolkit.  

Instructions for Verifying Level 2 Access and Toolkit Role

You can make sure that all steps in setting up Level 2 access have been completed as required by having a user login to their eAuthentication account as follows:
29. In Internet Explorer, go to http://www.eauth.egov.usda.gov/
30. Click on the Update Your Account link at left. 
31. A security warning will appear, click Continue. 
32. Type in User ID and Password, then click Login. 
33. Once logged in, click on the View My Roles link at left. 
34. This window should appear.
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In the above screen, an NRCS type access role should be listed.  As the screen shot shows, user’s Level 2 Admin Role is confirmed (YES is listed under 'Can Use Role').  

For Further Assistance

If you are able to verify that all the above is set properly for the user and you still do not see the user in the drop-down list, please email ToolkitSupport@ftc.usda.gov for assistance.  A support specialist will contact you to resolve the problem.
Installation
Installation Assistance

Installations are now accomplished by system administrators.  As they become available, new installation packages are posted to the ITS Team Services Web site.  Users should contact their local ITS staff to arrange for the installation of new software releases.  For assistance in installing Toolkit, ITS staff may send email to ToolkitSupport@ftc.usda.gov, or contact the Help Desk by phone, 1-888-311-1444, or via the Web, https://merlin.sc.egov.usda.gov/magicsshd/.  
Installation Prerequisites 

Software Requirements

Before installing Toolkit 2004 on a workstation/laptop, verify that the system has the following software installed:

· CCE Windows XP with SP 1 (CCE Update CD #1)

· Microsoft .NET Framework 1.1 Toolkit 2004 on a workstation/laptop, verify that the system has the following software installed (CCE Update CD #1)
· Microsoft Office XP (Professional Version)

· CCE Version of ESRI® ArcGIS 8.3 (or ArcEditor 8.3) with SP-3 

· Single license required for field users with laptops

· Multi-user license required for site users 

· For specifics, see the CCE Team Services Web site.

Note:  Toolkit 2004 should only be installed on a CCE configured workstation.

Hardware Requirements

Prior to installing Toolkit 2004 with ArcGIS 8.3 or ArcEditor 8.3, verify that the hardware has sufficient memory to operate ArcGIS (see Appendix B). 

Network Requirements

In order to install Toolkit on a laptop or desktop workstation, you must have either:

· A USDA network

· A USDA VPN access (for more details, consult the following Web page:
http://www.itc.nrcs.usda.gov/toolkit/default.htm)

Note: Dial-up connections are not supported by Toolkit 2004.

ArcGIS Issues
Common Cause of ArcGIS Problems
Problem:  A user is having issues with ArcGIS, and these problems are only evident on one user workstation.  

Resolution:  When a user is having issues with ArcGIS, the first thing to check is that all the hardware requirements are being met (see the Installation Guide for details).  In particular, verify that the workstation has sufficient RAM (512).  If the workstation has sufficient memory, another thing to check for is errors with other applications installed on that machine.  When possible, ask the ITS staff to examine the workstation (e.g., error logs, missing .dll files, O/S issues) to rule out general system problems or incomplete software installations.
Issue with Editing Attribute Tables in ArcGIS

Problem:  User edits records in Attributes Tables, which corrupts their Toolkit data.

When using ArcGIS, users SHOULD NOT attempt to edit records in the Practice or Planned Land Unit Attribute Tables.  Doing so will result in problems which the Toolkit support staff may not be able to resolve.  It is also important that user do not attempt to edit the Practice or Planned Land Unit spatial layer with the table open.  Editing the Practice Layer or Planned Land Units Layer with the table open, then checking the customer in and out again, will lead to corruption of your Toolkit data.  In addition, other parts of Toolkit that have links to this data will not work properly and almost always, will produce an error.

One of the most common data issues resulting from this undesirable practice is the deletion of data (e.g., a land unit or a practice).   
Advanced Setting In Preferences Lost

Problem:  The first time a user runs Toolkit after installing SP-1, the Advanced setting for GIS User Level is no longer the set value in Toolkit Preferences.

Scope:  SP-1
Resolution:  Installing SP-1 automatically resets two preferences: (1) on the GIS Tools tab, the “Advanced” GIS user level is reset to “Basic” and (2) on the Choice Lists tab, all NRCS Land Use choices are reset to Selected.  To resolve this problem, before running Toolkit for the first time (after SP-1 is installed), an advanced GIS user should open Toolkit Preferences and review, revise, and resave the settings.   To resave all Preferences settings, click on the Preferences menu and select Save All.

Corrupt .mxd Templates
Problem:  A user is having issues with ArcGIS, and the workstation has met all the hardware requirements.  

Scope:  Any current version of Toolkit
Resolution:  Using a corrupt ArcGIS template is another common cause of ArcGIS issues.  To check whether the issues are due to a corrupt template, use the default ArcGIS template (ToolkitGIS_template.mxd, then see if you can reproduce the problem in the default template.  If you can, contact ToolkitSupport@ftc.usda.gov for assistance.  If you cannot reproduce the problem, then delete the corrupt .mxd file, and then start over, using the default template.  In most cases, no data is lost.  However, any customization of the template that was done in the corrupt version will need to be recreated.
Preserving Customized Templates Prior to Software Upgrade

Problem:  After upgrading to a new version of Toolkit, the user’s customized ArcGIS template is gone.

Scope:  Build 66 and SP-1

Details:  Installing a new version of Toolkit 2004 will overwrite templates customized from the ToolkitGIS_Template.mxd file if the template is named ToolkitGIS_Template.mxd.  (The Toolkit installation process overwrites the ToolkitGIS_Template.mxd file with the latest version that is included in the installation package.) 

Resolution:  If a customized ToolkitGIS_template.mxd file is saved to the C:\Program Files\usda\Toolkit 5\Templates folder, rename this file before ITS installs the new version of Toolkit 2004 on this workstation. 

Note:  Users do not need to rename any of the other .mxd files in the Customer Files folder.

Import Legacy Shapefile

Problem:  Geometries are projected into the wrong location (e.g., the Atlantic Ocean) when using the Import Legacy Shapefile tool.

Two known issues with importing legacy shapefiles are described below in scenarios 1 and 2.  

Scenario 1

The original shapefile data was digitized in the State Plane projection using Toolkit 4.1/ArcGIS 3.x.  If the user has their Toolkit Preferences set to a different projection (anything other than State Plane), the file will import incorrectly into Toolkit 5.0, thus causing the geometries to shift to an incorrect location.  

Resolution:  When using the default projection for your shapefiles, if the geometries shift to the wrong location, please contact ToolkitSupport@ftc.usda.gov for assistance.

Scenario 2

In an office that works with multiple counties, that span two different zones ,the following problem is known to occur.

Example:

The user’s preferences are set to UTM NAD 83 Zone 15.

The user checks out a folder that has a TK 4.1 consplan.shp file that was originally digitized in Zone 16. 

The user bring the land units into Toolkit v5 using the Import Legacy Shapefile tool.

Since Preferences are set to Zone 15, the tool creates a consplan.prj for Zone 15, when it  should be recorded as 16.  This causes the land units to shift (in this case to the west).  

In this scenario, the user may notice that there is a problem in PRS, because the push pins would show up in the wrong location.  

Resolution:   To correct the erroneous land units, follow these instructions.

35. Open the customer’s plan in Toolkit/ArcGIS.

36. Start editing the PLU layer.

37. Select all features in the layer, then press the Delete key.

38. Close ArcGIS, open Preference and set the zone to the one used when the consplan.shp was created in TK 4.1.  Save and close Preferences.

39. Click on the Customer File tab, and navigate to the Plan Maps/Plan directory.  

40. Delete the consplan.prj file.

41. Navigate to the ArcGIS_Projects folder and open the customers project.

42. Click on Cyber Farmer to load the plan layer.

43. You should get a message saying no spatial records were available.

44. Click OK.

45. Use the Import Legacy Shapefile tool to import the shapefile and link to the tabular land units.

46. Stop Editing (save changes).

This issue can be preventing by creating a .prj for the shapefile in the correct zone before using the Import Legacy Shapefile tool. .  By doing so, Toolkit will not create an erroneous .prj file using the default zone set in Preferences. 

Another option is to reset Preferences to the correct Zone before importing the shapefile.  (Be sure Preferences is set back to the preferred zone after importing the shapefile so other customer folders are not negatively affected.)

A third option is to use a utility that will go through all customer files and create .prj files for all shapefiles that do not have one.  This solution works well for offices that have their folders separated by county.  If County A is in Zone 15 the users can create the zone 15 .prj in one step by running the utility on the Customer Files Toolkit\County A folder.    Then they can run the script again on the Customer Files Toolkit\County B folder and create all the .prj files in Zone 16.  Note:  running the script on the F:\Customer Files Toolkit directories will require admin privileges.  To obtain this script and instructions, contact ToolkitSupport@ftc.usda.gov.  
Editing Legends
Problem:  Editing legends consumes so much time.  

Scope:  Any current version of Toolkit

Helpful Hint:  Users may develop style sheets to make the editing of legends more efficient.  For example, a style sheet for Practice Layers is available on the Toolkit Web site at http://www.itc.nrcs.usda.gov/toolkit/training.htm.

This style sheet, developed by Sean Browning, can be used as a great short cut for legend editing when working with Toolkit 2004 customer folders.  The styles include point, line, and polygon practices.  Also available on this web page are instructions for using the style sheet and a short demo of how to use style sheets (from the Live Meeting training session held on 5-11-05).

Editing Soils Maps

Problem:  When creating a soil map for a PLU Layer, the land unit boundaries are included on the map.  Users would like to create a soils map without these boundaries.

Scope:  Any current version of Toolkit

Helpful Hint:  Use the procedure developed by Toby Alexander, which "clips out" the soils map, based on the PLU layer, without intersecting the two layers.  This procedure, available in PDF format (filename:   VTToolkitHelp_5.pdf) at

ftp://ftp-fc.sc.egov.usda.gov/VT/Technical/Customer_Service_Toolkit/Help
makes labeling the soils map much easier and produces maps that are less confusing for producers. 

In the procedure, the buffer option in the soils inventory tool is used.  The clipped layer is achieved by setting the buffer to 1 foot.  

Multiple Practice Points

Problem:   A planned land unit (PLU) has multiple practice points, and now I want to move one of them. 
Resolution:  Follow these instructions.  (In this example, the PLU has one land unit, with four practice points.)
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47. In ArcMap, open up the Practice Points layer for editing.
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48. Open the ArcGIS Topology Bar (right-click in the gray area of the ArcGIS Menu and select Topology).
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49. Click on the “Map Topology” button on this toolbar.
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50. When the Map Topology dialog window appears, click on the following layers:  Practices (points) and practice_instance_point.
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51. Click OK.

52. Click on the Topology Edit button on the Map Topology toolbar.
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53. Click the desired point to move, to highlight, and then hover over the point, and the cursor will change to a crosshair, and while holding down the right mouse button, move the point.  
54. Close the Topology Bar, and then on our Editor toolbar, Stop Editing/save.
55. Check your work (go back and check the attributing for this point you just moved, to ensure that you did not move it from one land unit to another).
Tools Menu

Features and utilities available on the Tools Menu include Toolkit Preferences, Reload Domain Data, Release Lock on Folder, and others.  This section provides troubleshooting information on components of the Tools Menu.

Problematic Characters in New Customer Names
Problem:  After creating a new customer, check-in does not seem to be working as it should, or after creating a new customer, the record is not showing up in the NCPDB.

Resolution:  First, rule out that the problem is not because the customer name contains a symbol or other invalid character.  If the customer name does not seem to be the problem, then send email to ToolkitSupport@ftc.usda.gov to request assistance.

Release Lock on Folder

Problem:  I am unable to release the lock on a folder that is reserved to me.  

Resolution:  SP-1 provides two menu items for releasing a lock on a Customer Folder.  Users are only able to release the lock on folders checked out to them.  If a user is unable to use the Release Folder Lock option on the Tools menu, first verify that the folder is reserved to this user.  You can determine this by going to the Check In/Out tab and locating this Customer Folder in the NCPDB list (at left).  If checked out to the user, select Tools ( Release Folder Lock.  If this menu option is grayed out, the user may not have the folder currently checked out on that workstation.  Also, the user may not have permission to release the lock on the folder (Toolkit Read/Write All is required for this feature).  Finally, the user may still have the Customer Folder open.  If this is the case, close the Customer Folder, then select the folder in the Folders Tab, then select Tools ( Release Folder Lock.  

Framework Tabs

Check In/Out Tab
Only Tabular Data is Available for Check Out

Problem:  When user tries to check out a customer, a message appears saying that only Tabular Data is available.

Resolution:  After using Check In Wizard to check in one or more customer files created in Toolkit 4.1, when the user attempts to check out one of the customers (that was presumably checked into the NCPDB), the user obtains a message that says that the customer file does not exist on the F: drive.

As the error message says, this file may not have been moved or copied from its previous location (F:\Customer Files) to F:\Customer Files Toolkit.

If the customer file can be found in one of these locations:

· F:\Customer Files
· C:\Customer_Files

56. Check out the customer folder from the NCPDB.

57. Before opening up the customer file in Toolkit, copy (or move) the folder to C:\Customer_Files_Toolkit.

58. Open the customer folder.

59. Verify that the Customer Files tab is available.

60. Select Tools ( Use Local File.

61. Click Use Local File. 

If the county you are working in has more than one endpoint set (i.e., two sites using the same county), a drop-down message is displayed allowing you to select the county to which you want to map this customer folder.

Click OK to the message that the new file is set for current customer and ready to check in.

A status bar indicates that the file is being backed up and checked in.
No Endpoint When Checking Out Customer Folder

Problem: User obtains an error message to select a server endpoint when checking out a Customer Folder.
[image: image10.png]Please select a server endp

The custome folder you are working with has o
server endpoint defined. If you know where the
folder resides, please select the appropriate
localon.

o Caresl





Resolution:  Follow this procedure.
62. Click the down-arrow to display a drop-down list. (If you do not know the location of the server, contact your local Toolkit/GIS coordinator.) 

63. Select the server for your field office's server on which the Toolkit folders are stored. 

64. Click OK. 

Cannot Check Folder Back In

Problem:  While checking in folder, a message says that Read-Only copy cannot be checked into the NCPDB.

Resolution:  Users can view locked folders in read-only mode.  However, you cannot make edits to these read-only files and check them back into the NCPDB.  The user will need to check out the folder as a write copy, make changes, and then check the folder back in.
Customer Tabs
General Tab

For assistance with issues that arise while working in the General Tab, contact ToolkitSupport@ftc.usda.gov.
Assistance Notes Tab

For assistance with issues that arise while working in the Assistance Notes Tab, contact ToolkitSupport@ftc.usda.gov.
Land Units Tab

Problem: User has a folder open and the toolkit menu options become inactive.  The user can navigate to the folder, but that is it.  He cannot close the folder, or utilize items on the Tools menu (because they are grayed out).
Resolution:  Check to see if the user is working in Land Units Tab when this happens.  If so, have the user finish entering the information for the land unit he is working on.  Toolkit needs at least the minimal information to be entered before it will release the desired menu items.  

Practice Schedule Tab

Duplicate Items in Contract
Problem:  A problem in the delete function in the Contract Wizard creates duplicate contract items.  The duplicate contract items interfere with the Protracts upload.   
Scope:  This information in this section applies to Builds 65 and 66.
Resolution:  When creating a contract in Toolkit 2004 Builds 65 or 66, do not delete contract items or components.  If you need to do this, delete and then recreate the contract.

Install Toolkit 2004 Service Pack 1 to resolve this issue.

Missing Narratives or Old Narratives

Problem:  Changes have been made recently to our practices and/or narratives and have encountered one or more of these problems:
A new practice was added using CPS, but they are not showing up in Toolkit.
A practice was replaced using CPS, but the new one is not showing up in Toolkit.
A new practice was added to a conservation system using CSG, but the new one is not showing up in Toolkit.
Practices that were replaced or retired from the national database are still showing up in the Toolkit Practice Schedule drop-down list.
Resolution:  Refresh the domain data on the workstation with data from the national database using the instructions provided below.
Scope:  Build 66 and SP-1
Introduction
After using the Conservation Practice Standards (CPS) application to change the state approved practice list, or using the Conservation System Guides (CSG) application to change conservation systems, the corresponding Toolkit workstation data needs to be refreshed with data from the national database.
Once an approved practice has been added to the state practice list and selected in Toolkit Preferences, the practice will display in both the All Practices block and the Conservation System block of the Practice Schedule tab.  While a replacement practice will display in these blocks, the replaced practice will not.

In the Practice Schedule tab, if a practice was scheduled prior to being replaced or removed from the state practice list, then the replaced or retired practice will be displayed in the Practice field in the Schedule block. The Practice field drop-down menu can be used change the replaced or retired practice with a state approved practice.

A “Reload Domain Data” menu item is now available with Toolkit 2004 v5 SP-1.  Selecting this item will force the domain data residing in the user’s geodatabase on their workstation to be refreshed. If you currently have Toolkit 2004 Build 66 installed, we recommend that you have ITS install Toolkit 2004 SP-1 and use the “Reload Domain Data” menu item as described in Part I below. If this procedure is impractical, follow the instructions in the Part II below.

Part I:  How to Refresh Domain Data in Toolkit 2004 v5 SP-1

1. Start Toolkit.

2. Select Reload Domain Data from the Tools drop-down menu.

3. Authenticate.

4. Click OK and wait for the geodatabase to synchronize.

5. Close Toolkit.

6. Start Toolkit.

Part II:  How to Refresh Domain Data in Toolkit 2004 Build 66

1. Check in all checked out folders.

Note: If you cannot Check In your customer folders, see Tech Note 006 available at:  
http://www.itc.nrcs.usda.gov/toolkit/training.htm#TechNotes
2. Close Toolkit.

3. Navigate to the geodatabase location:

C:\Documents and Settings\<user_name>\Local Settings\Application Data\USDA\Toolkit5\
4. Rename the geodatabase (e.g., rename Toolkitv50.mdb to Toolkitv50.mdb.bak)

5. Start Toolkit.

6. Authenticate.

7. Click OK and wait for the geodatabase to synchronize.

For Further Assistance

To request further assistance, contact the Toolkit Support team at ToolkitSupport@ftc.usda.gov, or visit Toolkit Online Help at:  http://cst.nrcs.usda.gov/Toolkit/Help/.
Problem Entering Month Manually in Practice Schedule

Problem:  In the Practice Schedule,the user cannot type in the month in the Month Planned field.

Resolution:  In SP-1, the month cannot be entered manually in the Month Planned field.  The solution is to select the desired month in from the drop-down menu for that field.
Problem:  All of the practice codes are not listed for a Conservation System Guide (CSG) in Toolkit Practice Schedule.  In addition, the correct practice narratives are not displayed in Toolkit. 

Resolution:  Even though both a retired and a replacement narrative may be visible in Toolkit Preferences or in the domain data on your workstation, only valid practices can be scheduled and reported.  Therefore, replace any retired practices with the new (replacement) practice (see instructions, below, for details).  If any narratives are missing, contact your State or Local Conservation Practice Standards data steward and request that they add the missing narratives.  Use the instructions provided below to correct invalid practices in the Practice Schedule.
Invalid Practices

Toolkit users will encounter problems when they attempt to schedule or report a retired practice.  Retired practices that exist in legacy (Toolkit 4.1) data, or that were created in Toolkit 2004 v5 prior to being retired, can be seen in the Practice Schedule.  An example of a recently retired practice code is 528a – Prescribed Grazing.  This practice code, retired in June 2005, was replaced with practice code 528.  Because the code was retired, it will no longer appear as a choice in Toolkit when scheduling practices.  

Correcting an Invalid Practice Code in the Practice Schedule

Use these instructions to modify invalid practice codes.  When a practice is retired, not all states updated their Conservation System Guides (CSGs) at the same time.  For states that have updated their CSGs to reflect the replacement code (in this example, 528), the retired practice (528a) is no longer visible in Toolkit in the Conservation System block in the Practice Schedule. 

When working in the Practice Schedule Tab of Toolkit 2004, you may encounter instances of a retired practice code (528a) in the data rows displayed in the Schedule block.  You will not be able to report these practices after checking in the customer folder to the National Conservation Planning Database, because PRS no longer allows this practice to be reported.  

Instructions

Note:  In the instructions below, the recently retired practice code, 528a, is used as an example for showing how to change a retired practice to its replacement practice.  

65. In the Schedule block of the Practice Schedule, select the invalid practice code (e.g., “528a”).

66. Select the corresponding replacement code (in this example:  “528”).

67. Repeat the above steps for each invalid practice code.

68. Save your changes.

Once all occurrences are corrected, you should be able to report these practices after checking in the customer folder.

For Further Assistance

For further assistance, contact Toolkit Support at ToolkitSupport@ftc.usda.gov.   
Corrupt Database

Problem:  User obtains one of the following errors.
This constraint cannot be enabled as not all values have corresponding parent values.
Error creating Practice Instance View
The application will now close. 
Error in adding domain table relationship Practice_to_StatePractice. addTableData Relation(). This constraint cannot be enabled as not all values have corresponding parent values. 
Plan could not be opened. Error message: PracticeSchedule.PlanServer_PlanOpened() error -- Object reference not set to an instance of an object.
Resolution:  Follow these instructions.
69. Make a backup copy of the personal geodatabase (filename Toolkitv50.mdb), located here: 
C:\Documents and Settings\<user name>\Local Settings\Application Data\USDA\Toolkit5\Toolkitv50.mdb 
  

70. Make a copy of the C:\Customer Files Toolkit folder to backup the customer files that are currently checked out. 

71. Using Toolkit 2004, check in all customers. 

72. Close Toolkit 2004. 

73. Close ArcGIS (if open). 

74. Delete the personal geodatabase (filename Toolkitv50.mdb), located here: 
C:\Documents and Settings\<user name>\Local Settings\Application Data\USDA\Toolkit5\Toolkitv50.mdb.  

75. Open Toolkit 2004. 

76. Check out those customers that you had previously checked out. 

77. Make your changes to these customers in Toolkit 2004. 

78. Check in your changes. 

79. If you encounter errors during check in, contact ToolkitSupport@ftc.usda.gov for assistance.
ProTracts Upload Error

Problem/Issue:  When trying to upload contracts to Protracts, this error occurs ‘Upload error.  No practice instance records exist.  Conservation contract item [alphanumeric string].’

Resolution:  Two different resolutions are provided below. 

When attempting to upload a contract, Protracts gives this message.  
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Then, when going to Toolkit, the following error displays from Contract Wizard build 66 after a Save. 
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· This is usually caused by the user not clicking on Save in Contract Wizard after they have assigned all land units and practices. When the user only clicks on Next there is no prompt to save.  

· The ‘invalid unit types’ warning is issued because the unit types are lost (after converting to Toolkit 2004 v5.0 Build 66 from Build 65, or after a check in / check out).

Resolution 1 – Contract is hard to recreate, data not corrupt

1. To repopulate unit types, go to Practice Scheduler, select the land units, click on Save.

2. Go to Contract Wizard, select the contract (selectable because it could not be obligated in ProTracts), verify land units and contract items are selected, click on Save.

Resolution 2 – If corrupt data is suspected

1. To repopulate unit types, go to Practice Scheduler, select the land units, click on Save.  

2. Go to Contract Wizard.

3. Create a new contract.

For Further Assistance

If the resolutions provided here do not resolve the problem, send the ProTracts contract number and Toolkit customer folder name to ToolkitSupport@ftc.usda.gov and ProTractsSupport@ftc.usda.gov. 

Customer File Tab

Duplicate Customer Records in the NCPDB

Problem:  There are two or more duplicate records in the NCPDB and only one Customer File on the F: drive.
Resolution:  Follow these steps to remove the duplicate record.

80. Identify the two or more Customer Files in the NCPDB that are duplicated.
81. Check out the Customer Files that have been identified as duplicates (so that they will be present in both C:\Customer_Files_Toolkit and the PGDB.
82. Copy the Customer Files from C:\Customer_Files_Toolkit to another location on the C:\ drive (i.e., C:\temp).

83. Select the unwanted duplicate Customer File(s) in the Folders tab of Toolkit 2004.  (Hint:  Open each duplicate record and review the contents to determine which records you want to keep.)

84. Using the delete folder button (the last icon on the vertical toolbar) in the Folders tab of Toolkit 2004, delete the folder.  (This will remove the customer folder from the PGDB, C:\Customer_Files_Toolkit, and the NCPDB.)

85. Copy the Customer File (that you created in step 3) from C:\temp back to C:\Customer_Files_Toolkit.

86. In the Folders tab of Toolkit 2004, double-click on this Customer to open it.  

87. On the Tools Menu, select Use Local File.

88. Answer the questions in the affirmative. 

89. Toolkit 2004 will check in the folder to the NCPDB and move the files from the C: drive to the local server (F:\Customer Files Toolkit).

Reporting Tab

Problem:  When I am working in the Reporting Tab in Toolkit 2004 v5, the items that I have selected to report are not being reported in PRS.

What do I need to do to make these reportable practices show up in PRS?
Resolution:  Make sure that you click the Report After Check In button before you check in the customer folder.  This step will allow practices to be reported once the folder is checked back into the National Conservation Planning Database (NCPDB).  The practices you reported via the Toolkit Reporting tab will be visible in PRS immediately after the plan is checked in and visible in the PRS reports once the nightly PRS data warehouse update has been completed.  For more details, see the procedure outlined below.  
Introduction
The Reporting Tab is new to Toolkit 2004.  This document outlines the proper procedure for reporting practices, and covers the main business rules implemented in the Toolkit 2004 v5 Reporting Tab. 
Reporting Tab Overview

Use the Reporting tab to:

· View conservation guide and conservation management system information
· View reportable practices
· Select the organization that performed the conservation work
· Select practices to automatically report in PRS
Although previously PRS was the only software application for reporting practices, you may now do your reporting via the Toolkit Reporting tab.  
The Reporting tab is active when a customer folder is open.  If the tab is not visible, follow the instructions to Select and Open a Customer Folder in the Toolkit Online Help system.
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 Figure 1.  The Reporting Tab is the tab furthest to the right.  Click on the Reporting Tab to navigate to the Reporting screen.

How to Report a Practice

The instructions for reporting a practice via the Reporting tab are as follows.  

90. Select a plan using the drop-down list in the Conservation Plan block.
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Figure 2.  Conservation Plan block with Plan set to “Consplan-Sample.”

91. Set the plan approval date.

92. In the Work performed by area, select one or more organization(s) that performed the conservation work.

93. The plan information, land units, and practices will be displayed.  

Note:  Applied practices that were reported in previous fiscal years will not be displayed.

94. Select the desired Land Unit(s) in the Land Units block.
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Figure 3.  Land Units block with Land Unit 1 selected.

95. Notice that upon selecting the desired Land Unit(s) (Figure 3), the reportable practices, if any, will appear in the Reportable Practices block.

[image: image16.png]Guide:

Practice
28
2%
590
595

NE 86.1-CR Dipland

Plerned Date
5/1/2008
5/1/2008
5/1/2008
5/1/2008

Plered At
169
174
174
174

Plerned Units

Diyland Cropland (Nor Erodibl]

Report At
189
174
174
174

Report Urits

FRS (FY)

dd9<




Figure 4.  Practices 328, 329B, 590, and 595 are reportable in this example.

96. Also, the check box in the PRS (FY) field will be checked [image: image17.png]


 for practices that are reportable. 

Note:  Before a practice can be reported, the following information needs to be set:  a valid latitude/longitude, a valid national land use, and a valid national practice.  In addition, the following information needs to be set in this order:  (1) the CRA in the Land Units tab or ArcMap, and (2) the Conservation System Guide (CSG) and Conservation System in the Practice Scheduler. 
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Figure 5.  Only practices with a check mark in the PRS (FY) column can be reported. 

97. If you do not wish to report a practice, uncheck the checkbox in PRS (FY) column.
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98. Click the Report After Check In button to allow practices with a checkmark [image: image20.png]


 to be reported. 
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99. After clicking on the Report After Check In button, the check mark will change to the current fiscal year for items that were checked in the PRS (FY) column in step 7 of this procedure (see Figure 6).
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Figure 6.  For items that were checked in the PRS (FY) column in step 7 of this procedure, the check mark will change to the current Fiscal Year (2005, in this example).

100. Click Save.  
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Warning:  You must click Save to have your work saved in your local geodabase (.mdb) file.  Your data will not be available in PRS after checking in the customer folder if you do not click Save.

101. Check the customer folder back into the National Conservation Planning Database (NCPDB) to complete the reporting process.

Note:  The practices you reported via the Toolkit Reporting tab will be visible in PRS immediately after the plan is checked in and visible in the PRS reports once the nightly PRS data warehouse update has been completed.
 Viewing the Reportable Practices in PRS

102. Log into PRS and find the customer.
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103. Click on the Customer Name, in this example:  “Michael Armstrong”, to bring up the Conservation Plans for this customer.
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104. Click on the plan of interest (“Consplan-Sample” in this example) to bring up this screen.
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105. Click on the Land Unit Tab to navigate to the following screen.   Note that the Land Use and Conservation System associated with each land unit are displayed.
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106. Click on the Practice Tab to navigate to the following screen.  Note that the practices that you selected to be reported (using Toolkit 2004) are displayed.
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PRS identifies common known errors with the following symbols:
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If you need further assistance in using:

· PRS, contact prs@nrcs.usda.gov, or visit PRS Online Help at http://ias.sc.egov.usda.gov/PRSHOME/ 

· Toolkit 2004, contact Toolkit Support at ToolkitSupport@ftc.usda.gov, or visit Toolkit 2004 Online Help, go to:  http://cst.nrcs.usda.gov/Toolkit/Help/.

Utilities

Data Cleaner

The Toolkit Data Cleaner is installed on each workstation as part of the Service Pack 1 installation package.  If you are running Build 65 or 66 of Toolkit v5, then you will need to download the data cleaner from the Web site, using the instructions below.  If you have SP-1 on your workstation, Skip to the “Instructions” section below.  

Problem:  My customer folder will not check back in.  

Resolution:  The resolution for this problem will depend on the underlying cause.  When Build 66 is installed on a user workstation, one possible problem is that  before contacting their Toolkit Coordinator or Toolkit Support.
107. Use your workstation explorer to navigate to the Data Cleaner utility (in SP-1, C:\Program Files\USDA\Toolkit5\Utilities).  
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108. Double-click on ToolkitDataCleaner.exe.
109. The following window will appear.  
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110. Verify the path to the default personal geodatabase location, or click on Browse to locate and select the geodatabase to be cleaned (once you have selected the .mdb file click on Open.  

· The default location is:
C:\Documents and Settings\<user name>\Local Settings\Application Data\USDA\Toolkit5\Toolkitv50.mdb
111. Click on the Clean GeoDatabase button.
Note:  If the utility will not run, check that you are executing it from somewhere on the C:\ drive.  The utility will not run from a mapped network location, such as H:\.
112. Wait while the Toolkit Data Cleaner utility cleans the geodatabase and displays the results.  The process completes in 10 seconds, but may take up to 2 minutes, depending on the size of your personal geodatabase.

113. A log file is automatically generated to store the information that appears in the Results block located at the bottom of the Toolkit Data Cleaner screen.  
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114. The following message in the Results block indicates that the cleaner has executed successfully:


C:\Documents and Settings\tmihaly\Local Settings\Application Data\USDA\Toolkit5\Toolkitv50.mdb

Finished. Results have been saved to the path:



C:\Documents and Settings\tmihaly\Desktop\Javier\GeoDbClean_632532191141303376.log

Feel free to copy this report and send it to ToolkitSupport@itc.ftc.usda.gov if you have any questions or require further assistance.  
Note:  This same information is saved in the log file that is generated by the Toolkit Data Cleaner.  The log file is saved in the same folder that the Toolkit50.mdb file resides.

115. Click on the red “X” button (at top right) to close the utility.
Verify Your Latest Changes

116. Open Toolkit.

117. Verify that you can check in and check out your customer folders.

118. If you encounter errors during check in, contact ToolkitSupport@ftc.usda.gov for assistance.
Note:  If you need assistance in running the Toolkit Data Cleaner, please contact ToolkitSupport@ftc.usda.gov.  A Toolkit specialist will contact you and walk you through the procedure detailed above.

FAQ: Disappearing Map Labels when Converted to Annotation
There are times that when two or more labels are overlapping that when they are converted to annotation will disappear from the screen. This is a known issue and has a quick workaround to get those that disappeared back.

Step 1: 

· Run the Toolkit2004 Map labels at least once so that ArcMap knows what you want to label.  If none of your labels disappeared you do not have this problem. If you had some disappear when converted to annotation go to step 2

Step 2: 

· Right Click on the Data View window and select “properties” in the dropdown. You should see
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· Click on the “Annotation Groups”  tab, you will want to click on the “Group Name” of whatever name you gave your annotation layer 

· Note: Default is the currently selected Consplan, in the case above, the annotation created was Toolkit2004 .

· Click on “Remove Group”. 

· Then click “OK” button. 

· Note: Do not panic, the labels on your map will disappear.

Step 3:


· Right Click as seen below on your currently selected Consplan and click on “Label Features” This will show all the labels on the map.  .
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· Next right click again on the current consplan, and click on Convert Labels to Annotation

Step 4:

· You should then see a dialog box like below:
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· Your selection should be exactly as shown above except for the name that is being shown should be your current consplans name.  

· The key things you will need to change are under “Create annotation for:” 

· Click on “Features displayed in the current extent” 

· uncheck the box for “Display overlapping labels in the overflow window” 

· Click OK.

Register Endpoints

ITS System Administrators or a State Toolkit/GIS Coordinator with a Level 2 eAuthentication account use the Endpoint Utility to register field office sites to the Customer Files Toolkit folder (or subfolder) on a field office server.  This task must be performed for every server where Toolkit 2004 customer folders will be stored. 

Note:  Endpoints need only be registered once for each field office server. (This process is not completed for each workstation, only for each server.)  If you are reinstalling Toolkit 2004, skip to Section 3.7.

To run the utility and register the endpoints, follow these instructions.

119. Using Explorer, browse to:
C:\Program Files\USDA\Toolkit5\Utilities\SetUpEndPoints.exe.

120. Double-click SetUpEndPoints.exe.
121. When the eAuthentication window is displayed, enter your User ID and Password.

122. Click Login.              
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123. When the Endpoint Utility dialog box appears, select your State from the drop-down list.
· A list of site offices is populated.
124. Select a Site Office from the Site Office drop-down list.  Select a County from the County drop-down list.
· Previously set endpoints will be displayed for this site.

125. Select an endpoint by:

· Typing in the server path to the Customer Files Toolkit folder location as the Endpoint (i.e., \\<server name>\data\Customer Files Toolkit), and clicking Add, or

· Clicking on the Browse button (folder icon) to browse to the server on the network and selecting the Customer Files Toolkit folder to create the endpoint. 

See Appendix A for example endpoints for the Toolkit site servers.
126. The server path is displayed in the dialog box (i.e., \\<server name>\data\Customer Files Toolkit).

127. If the endpoint already exists, a message is displayed. Click OK.

128. Click OK at the bottom of the Endpoint Utility dialog box to register the endpoint. 

129. The Endpoint Set message will appear.

130. Click on Yes to repeat this process for any other server where customer folders will reside. Click on No to exit the Endpoint Utility dialog box.

131. To delete an endpoint, select the server path displayed in the dialog box and click on the Remove button.
For additional information, see the “Registering Endpoints” section under Getting Started in Toolkit User Help.
Cannot Upload Shapefile[image: image37.png]



Problem:  I'm trying to upload a WRP shapefile using the Environmental Easements website.  The site will not allow me to upload the shapefile because it's not in the expected format.  Where do I find the easement upload preparation tool?

Resolution:  The Easements tool was based on ArcView 3.3 and is not available in ArcGIS.  Follow the instructions provided below to create a shapefile with the necessary attributes for uploading to the Easement Toolkit website.

How to prepare an easement shapefile for uploading
The Easement Toolkit website application will upload a shapefile if it has the following attributes:

	Name
	Type
	Length
	Precision
	Scale

	AGREE_NUM
	String
	15
	0
	0

	EASE_ACRES
	Float
	8
	7
	1

	EASE_LENGT
	String
	15
	0
	0

	METHOD
	String
	20
	0
	0


Although these attributes fields must be present, only the AGREE_NUM needs to have a value, the other attribute fields can be empty because they will not be uploaded by the Easement Toolkit website application. 

· You will need to enter the matching agreement number in the Easement Toolkit website application to upload the easement shapefile.

· The easement shapefile must be in a NAD 83 UTM projection. You will need to select the UTM Zone in the Easement Toolkit website application to upload the easement shapefile.

Instructions
Verifying Existence of Attributes
1. Start ArcCatalog and open your shapefile.

2. From ArcCatalog right click on your shape and select “properties”.
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3. In the “Shapefile Properties” window check that the properties AGREE_NUM, EASE_ACRES, EASE_LENGT and METHOD are present. If not you can add them in this window.
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Editing AGREE_NUM attribute

4. Make sure you are using the advanced ArcGis template: open Toolkit Preferences, check “advanced” from the GID User Level group box.
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5. Start ArcGIS using the ToolkitGIS_Template.mxd, or another Toolkit template.

6. From the File menu select Add Data, and browse to the folder where your shapefile is located. In this example, our shapefile is called Easement_template.shp.
7. Select Easement_template.shp and click the Add button.
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8. If a projection file has not been created for the Easement_template shapefile, then you will be prompted with the following message. Click OK. Then set the dataframe coordinate system to  the appropriate NAD 83 UTM projection.
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9. Open the polygon editor toolbar and select your shapefile’s layer for edit.
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10. While in Edit mode, for each shape in the newly edited easement layer:

a. Select the shape;

b. Click the Attributes button on the Polygon Editor toolbar;

c. When the Attribute table opens, click on the cell that corresponds to the ‘AGREE_NUM’ row and the ‘Value’ column, and enter the Easement agreement number.
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d. Close the Attributes table.

e. Repeat these steps to attribute each shape in the easement layer. 


Note: All shapes must have the same Easement agreement number.

11. From the Polygon Editor Toolbar menu, select Stop Editing. When prompted to save your changes click Yes.

Uploading shapefile to Easements Website

12. Log on to the Environmental Easements website.

13. From the menu select ‘add new easements’ and from the submenu select ‘upload an easement shapefile.’

14. The following dialog box will be displayed and fill in the values, making sure that the agreement number matches what you entered in the attribute for the easement shapes, while in ArcGIS. After the boxes have been filled in, click Submit.
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15. The following dialog box will be displayed. Click Browse… to browse to the Resource_Maps folder under the customer folder and select the shapefile (.shp extension), and then select the table file (.dbf extension), and fill in the appropriate UTM Zone and.
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16. Click the Submit button and your shape file will be uploaded.

Check In Wizard
Check In Wizard Installation FAQs
1. After installing the new Check In Wizard, will it use my “Last Check In Date” from the old Check In Wizard?

No.  This is an important point.  The “Last Check In Date” will default to January 1, 2003. You must be sure to set it to the correct date. Otherwise, you will risk checking in and replacing current customer folder data with older data. If you do not set the correct date, changes made to customer folder data using Toolkit 2004 and checked into the NCPDB get replaced by the older data.

2. Must Check In Wizard 1.00.0033 be removed by each user on the workstation before Check In Wizard 1.00.0035 can be reinstalled? 

Yes.  You must remove the Check In Wizard 1.00.0033 from each user account that has it installed before you can install the new version 1.00.0035. See section 3.7.1 of the Toolkit 2004 v5.0 Installation Guide v1.9 for instructions for each user to remove their installation of Check In Wizard.

3. What can I do if a user is not available to remove their installation of Check In Wizard?

A script, available at www.itc.nrcs.usda.gov/toolkit/remove.htm, will remove Check in Wizard 1.00.0033 information for each user installation that prevents installing Toolkit Check in Wizard 1.00.0035.  Download and unzip the CheckinWizardAccountRemoval.zip file.  Log on as an administrative user, then run the batch file CheckinAccountRemoval.bat.  A dialog box will be visible during the script's processing.  When prompted that processing is complete, exit the dialog box.

Next, install Check in Wizard 1.00.0035 as directed in section 3.7.1 of the Toolkit 2004 v5.0 Installation Guide v1.9.  When users log in to this workstation at a later date, they will see both installations of Check in Wizard in the Add/Remove Programs list.  They should remove the item named ‘Check in Wizard.’  Do not remove the item named ‘Check In Wizard - All Users.’
Note: After running the Check In Wizard removal script, if you are unable to install Check In Wizard 1.00.0035, contact Toolkit Support at ToolkitSupport@ftc.usda.gov for assistance.  

4. Is the Check In Wizard 1.00.0035 installation still a two-step process?

No.  The previous two-step installation process can now be accomplished in one step.

5. Where is the new Check In Wizard (1.00.0035) installation package?

Offices can no longer download the Check In Wizard directly. The Check In Wizard installation package is bundled with the Toolkit 2004 and Toolkit Utilities in the CSToolkit2004V5.0.66_PKG.zip file available from the CCE Team Services ITS Web Site under Supplemental Applications and Instructions.
6. Can multiple users still use the new Check In Wizard on the same workstation?

No.  The new Check In Wizard is supported only for use by one user on a single workstation; Multiple workstations and/or multiple users on a single workstation is not a supported configuration.

There can be problems if multiple users run the new Check In Wizard on the same workstation. When one user saves the “Last Check In Date”, that date set is set for the next user who runs the Check In Wizard.
Cannot Check In Customer Folder

Problem:  When using Check in Wizard, some of the customer files will not check into the NCPDB

Resolution:  First verify that there is a consplan.mdb file in the Customer File on the C:\ or F:\ drive.  Customer files that do not have a consplan.mdb file (or that have key data missing in an existing consplan.mdb file) cannot be checked into the NCPDB with Check In Wizard.

Document the Problem
Help desk personnel can assist the support team in resolving an issue expediently by gathering some basic information about the issue a user encounters.

First, document the steps or actions the user performed just prior to the error.  
Second, when possible, have the user:  

· Capture the error or warning message by simultaneously pressing the Ctrl and Print Screen buttons on the keyboard (to copy the message), then paste the screen shot into a blank MS Word document and save the document (if a support person is not readily available).   Ask the user to email the document to Toolkit Support (have the user include the Magic ticket number in the subject line).

· If possible, leave the message visible until the support person can see it (the Toolkit technical support team may schedule a net meeting with the user).
Third, ask the user what version of Toolkit s/he is using.  See instructions for checking current Toolkit version, below.   (Instructions for determining which version of Toolkit is installed on a client workstation are also provided under “Check Current Version” on the Toolkit 2004 FAQ page at http://www.itc.nrcs.usda.gov/toolkit/faq_main.htm.) 

MXD Doctor

The MXD Doctor, developed by ESRI, is a utility for recovering corrupt .mxd files. The MXD Doctor is installed during Toolkit 2004 installation at C:\Program Files\USDA\Toolkit5\bin\MXdocfor.dll.

For instructions on how to configure and use the MXD Doctor and MXD Defragmentor, see the ESRI® Web site at: http://arcobjectsonline.esri.com/ArcObjectsOnline/default.asp?.
Appendix A:  Toolkit Online Help
To search for information in Toolkit 2004 Online Help, follow these instructions.

1. In Internet Explorer, go to    http://cst.nrcs.usda.gov/Toolkit/Help/.

2. When Online Help appears, click on the Search box, located at top right.
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3. Type in a topic or keyword, then depress the [Enter] key.  (For example, type “Check In”.)

4. The search results will appear in the left frame.
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Organization

To assist you in using Toolkit 2004, detailed instructions are available in two formats
Web format (html help docs) and printer-friendly (WS-Waord) format. The instructions are
organized info several user guides (aka, help books) as autlined in the table below.

User Guide: Audience Contents

Creste & Resource Invertory
(Creste an Assistance Notes Report
| Customer Files Tab

Welcome: Anyone who uses Toolkit

« Conventions and Format for User Guide
« Where to Get Support





5. Left-click on a topic (e.g., “Check In/Out Tab”) in the left frame.
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6. The selected topic will appear in the right frame.
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Check In/Out Tab

Toolkit 2004 automates the Check Tn/Out process. With Toolkit, you can check out
customer data that was checked info the NCPDB using the Check Tn Wizard or using PRS,
Toolkit allows you check out all of the data for a particular customer, including the
customer file From the server, or just the tabular data from the NCPDB. In the case where
there is no associated customer File (e.g., customer data checked in through PRS), Toolkit
can create the customer File for you. Once the data has been checked out from the
NCPDB, it is stored as a Customer Folder in Toolkit.

1. To select the Check In/Out tab, start Toolkit.

2. To access the Check In/Out fab, start Toolkit, B
3. After Toolkit is started, the following fwo fabs are displayed,

' Customer Service Toolki

Tools Reports _Help
SO L
CheckIn/Out | Folders |

o Check In/Out (example)
o Folders (exanple)

m |
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Once the Report After Check In button has been selected, the checkmarks change to the Fiscal Year in which the practice will be reported.













































































































































































































































































































































































ii 

USDA  /  NRCS  /  ITC 
USDA  /  NRCS  /  ITC  

iii

